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You use mail merge when you want to create a set of documents, such as a form letter that is sent to 

many customers. Each document has the same kind of information, yet some of the content is unique. For 

example, in letters to your customers, you can personalize each letter to address each customer by name. 

The unique information in each letter comes from entries in a data source.  

The mail merge process entails the following overall steps: 

1. Set up the main document. The main document contains the text and graphics that are the same for each 

version of the merged document — for example, the return address in a form letter. 

2. Connect the document to a data source. A data source is a file that contains the information to be merged 

into a document. For example, the names and addresses of the recipients of a letter.  

3. Refine the list of recipients or items. Microsoft Word generates a copy of the main document for each 

recipient or item in your data file. If you want to generate copies for only certain items in your data file, 

you can choose which items (or records) to include. 

4. Add placeholders, called mail merge fields, to the document. When you perform the mail merge, the mail 

merge fields are filled with information from your data file. 

5. Preview and complete the merge. You can preview each copy of the document before you print the whole 

set. 

You use commands on the Mailings tab to perform a mail merge. 

 IMPORTANT   If you plan to use custom contact fields with the Contacts list in Microsoft Outlook or if 

you plan to use a Public Folders Contacts folder, you must begin the mail merge process in Outlook. 

Set up the main document 

1. Start Word.  
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A blank document opens by default. Leave it open. If you close it, the commands in the next step 

are not available. 

2. On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge. 

 

3. Click Letters. 

You can also use mail merge to create: 

 A catalog or directory    The same kind of information, such as name and description, is shown for each 

item, but the name and description in each item is unique. Click Directory to create this type of document. 

 A set of envelopes     The return address is the same on all the envelopes, but the destination address is 

unique on each one. For more information, see Create and print envelopes for a mass mailing. 

 A set of mailing labels    Each label shows a person's name and address, but the name and address on 

each label is unique. For more information, see Create and print labels for a mass mailing. 

 A set of e-mail messages     The basic content is the same in all the messages, but each message goes to 

the individual recipient and each message contains information that is specific to that recipient, such as the 

recipient's name or some other piece of information. For more information, see Use mail merge to send 

personalized e-mail messages to your e-mail address list. 

Resume a mail merge 

If you need to stop working on a mail merge, you can save the main document and resume the merge 

later. Microsoft Office Word retains the data source and field information. 

1. When you're ready to resume the merge, open the document.  

Word displays a message that asks you to confirm whether you want to open the document, which 

will run a SQL command.  

2. Because this document is connected to a data source and you want to retrieve the data, click Yes. If you 

were opening a document that you did not realize was connected to a data source, you could click No to 

prevent potentially malicious access to data. 

The text of the document, along with any fields that you inserted, appears. 

3. Click the Mailings tab, and resume your work. 

Connect the document to a data source 
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To merge information into your main document, you must connect the document to a data source, or a 

data file. If you don't already have a data file, you can create one during the mail merge process. 

 IMPORTANT   If you use an existing list, make sure that it contains the information that you want to use, 

including all the columns and the rows. You can make some changes during the merge, but you can't 

open your data source separately during the merge. The merge process is easier if your data source is 

ready before you connect to it. 

Choose a data file 

1. On the Mailings tab, in the Start Mail Merge group, click Select Recipients.  

 
 

2. Do one of the following: 

 Use Outlook Contacts    If you want to use your Contacts list in Microsoft Outlook, click Select 

from Outlook Contacts. 

 

 

 IMPORTANT   For more information about using the Contacts list, see Tips for working with 

Microsoft Outlook Contacts list below. 

 

 

 Use an existing data source file    If you have a Microsoft Excel worksheet, a Microsoft Access 

database, or another type of data file, click Use Existing List, and then locate the file in the Select 

Data Source dialog box.  

 

For Excel, you can select data from any worksheet or named range within a workbook. For Access, 

you can select data from any table or query that is defined in the database. 

 

 

 IMPORTANT   For tips on formatting the data in your Excel worksheet for mail merge, see Tips 

for formatting data in Excel below. 

 

 

For another type of data file, select the file in the Select Data Source dialog box. If the file is not 

listed, select the appropriate file type or select All Files in the Files of type box. In a mail merge, 

you can use the following types of data files: 
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 Files from single-tier, file-based database programs for which you have installed an OLE 

DB provider or ODBC driver (a number of which are included with Microsoft Office 2010). 

 An HTML file that has a single table. The first row of the table must contain column 

names, and the other rows must contain data. 

 A Microsoft Word document. The document should contain a single table. The first row of 

the table must contain headings, and the other rows must contain the records that you 

want to merge. 

 Any text file that has data fields separated (or delimited) by tab characters, or commas 

and data records separated by paragraph marks.  

 Create a new data file in Word    If you don't have a data file yet, click Type New List, and then 

use the form that opens to create your list. The list is saved as a database (.mdb) file that you can 

reuse. For more information, see Type a new list. 

 NOTE   If you installed Microsoft Office 2010 (instead of installing Word 2010 by itself), you can also use 

Microsoft Query to construct a query and retrieve the data you want from an external data source. 

If you are ready to continue, go to the next step. 

If you need more information, read on. 

Tips for working with Microsoft Office Outlook 

Contacts list 

Connecting to your Outlook Contacts folder is usually a straightforward process, but sometimes you may 

encounter a problem. Here are solutions to common problems that you may encounter: 

 I can't find my Outlook Contacts folder to connect to it. 

 I get error messages about mail clients and tables. 

 I can't connect to an Outlook Contacts folder in Public Folders. 

I can't find my Outlook Contacts folder 

You may need to turn on the Show this folder as an e-mail Address Book property in Outlook, or you 

may need to change your Outlook user profile. 

Turn on the Show this folder as an e-mail Address 

Book property 

1. In Microsoft Outlook, click Contacts. 

2. Right-click the Contacts folder that contains the information that you want to use for a mail merge, and 

then click Properties on the shortcut menu. 

3. On the Outlook Address Book tab, make sure that the Show this folder as an e-mail Address Book 

check box is selected, and then click OK. 
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Change your Outlook user profile 

An Outlook user profile is a group of e-mail accounts and address books. Usually, you need only one 

profile — but if you share your computer with other people or use different address books for different 

purposes, you can set up more than one profile. If, when you start your mail merge, you're using a profile 

that doesn't include the Contacts folder that you want to use, that folder won't be available. 

To switch to a different user profile, restart Outlook. When you're prompted for a profile, choose the 

profile that includes the Contacts folder that you want to use in the mail merge. 

If you aren't prompted for a profile and you know that you have more than one, you may want to set up 

Outlook so that it prompts you. To do this: 

1. Exit Outlook. 

2. In Control Panel, click User Accounts, and then click Mail. 

3. Click Show Profiles. 

4. To be prompted to select a profile each time you start Outlook, click Prompt for a profile to be used, 

and then click OK. 

I get error messages about mail clients and tables 

If you try to connect to your Contacts folder during a mail merge in Word, and Outlook is not set up as 

your default e-mail program in Windows Internet Explorer, you will get an error message that says: 

"Either there is no default mail client or the current mail client cannot fulfill the messaging request. Please 

run Microsoft Office Outlook, and set it as the default mail client." 

To avoid getting this message during a mail merge, do the following: 

1. Click the File tab. 

2. Click Options. 

3. Under Start up Options, select the Make Outlook the default program for E-mail, Contacts, and 

Calendar, and then click OK. 

Start Word again, open your mail merge document, and connect to your Outlook Contacts folder. 

I can't connect to an Outlook Contacts folder in Public 

Folders 

If you start a mail merge in Word and try to connect to an Outlook Contacts folder in Public Folders, you 

get an error message that says: 

"The operation cannot be completed because of dialog or database engine failures. Please try again later."  



If you try again later, you get the same error message. 

To use a Public Folders Contacts folder as the data file for your mail merge, you have to start the mail 

merge from within Outlook. 

Tips for formatting data in Excel 

If your data file is an Excel worksheet that includes percentages, currency values, or postal codes, you can 

preserve the numeric formatting of the data by using Dynamic Data Exchange to connect to the Excel 

worksheet from Word. For example, you can make sure a five-digit postal code of 07865 from your data 

file is not displayed as the number 7865 (without the leading zero). 

Before you connect to the worksheet, do the following in Word: 

1. Click the File tab. 

2. Click Options. 

3. Click Advanced. 

4. Scroll to the General section, and select the Confirm file format conversion on open check box. 

5. Click OK. 

6. With the mail merge main document open, in the Start Mail Merge group on the Mailings tab, click 

Select Recipients, and then click Use Existing List. 

7. Locate the Excel worksheet in the Select Data Source dialog box, and double-click it. 

8. In the Confirm Data Source dialog box, click MS Excel Worksheets via DDE (*.xls), and then click OK. If 

you don't see MS Excel Worksheets via DDE (*.xls), select the Show all check box. 

9. In the Microsoft Excel dialog box, for Named or cell range, select the cell range or worksheet that 

contains the information that you want to merge, and then click OK. 

 NOTE   To prevent being prompted every time you open a data file, you can clear the Confirm 

conversion at Open check box after you connect to the worksheet. 

Type a new list 

1. In the New Address List dialog box, type the information for the first address, or record, that you want to 

include in your mail merge. 

If you want to add or remove columns, click Customize Columns, and then make the changes that 

you want. 

2. After you type all the information for your first record, click New Entry, and then type the information for 

the next record. Continue until you have typed information for all the records that you want to include. 

3. When your new list is complete, click OK. 

4. In the Save Address List dialog box, type a name for your new list, and then click Save. 

Refine the list of recipients or items 



When you connect to a certain data file, you might not want to merge information from all the records (or 

rows) in that data file into your main document. 

If you plan to use your entire list, you can skip ahead to the next step. 

To narrow the list of recipients or use a subset of the items in your data file, do the following: 

1. On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List. 

 

2. In the Mail Merge Recipients dialog box, do any of the following: 

 Select individual records    This method is most useful if your list is short. Select the check boxes 

next to the recipients you want to include, and clear the check boxes next to the recipients you 

want to exclude.  

 

If you know that you want to include only a few records in your merge, you can clear the check 

box in the header row and then select only those records that you want. Similarly, if you want to 

include most of the list, select the check box in the header row, and then clear the check boxes for 

the records that you don't want to include. 

 

 Sort records    Click the column heading of the item that you want to sort by. The list sorts in 

ascending alphabetical order (from A to Z). Click the column heading again to sort the list in 

descending alphabetical order (Z to A). 

 

If you want more complex sorting, click Sort under Refine recipient list and choose your sorting 

preferences on the Sort Records tab in the Filter and Sort dialog box. For example, you can use 

this type of sorting if you want recipient addresses to be alphabetized by last name within each 

postal code and the postal codes listed in numerical order. 

 

 Filter records    This is useful if the list contains records that you know you don't want to see or 

include in the merge. After you filter the list, you can select or clear the check boxes to include or 

exclude records. 

To filter records, do the following: 

1. Under Refine recipient list, click Filter. 

2. On the Filter Records tab in the Filter and Sort dialog box, choose the criteria that you want 

to use for the filter. 

For example, to generate letters only for addresses that list Australia as the 

country/region, you click Country or Region in the Field list, click Equal to in the 

Comparison list, and then type or select Australia in the Compare to list. 
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3. To refine the filter further, click And or Or and choose more criteria. 

For example, to generate letters only for businesses in Munich, you filter on records 

whose City field contains Munich and whose Company Name field is not blank. If you 

use Or instead of And in this filter, your mail merge includes all Munich addresses as 

well as all addresses that include a company name, regardless of city. 

 Add recipients    To add recipients to the list, do the following: 

1. Under Data source, click the name of your data file. 

2. Click Edit. 

3. In the Edit Data Source dialog box, click New Entry, and then type the information for that 

recipient. 

 TIP   Depending on the type of data source that you use, some processes might not be 

available. If possible, make sure that your data file is complete before you connect it to your 

main document. 

 NOTE   If you have installed address validation software, you can click Validate addresses in the Mail 

Merge Recipients dialog box to validate your recipients' addresses. 

Add placeholders, called mail merge 

fields, to the document 

After you connect your main document to a data file, you are ready to type the text of the document and 

add placeholders that indicate where the unique information will appear in each copy of the document. 

If you are familiar with how mail merge fields work, you can skip ahead to mapping and merging. 

If you want to learn more about how mail merge fields work, read on. 

About mail merge fields 

The placeholders, such as address and greeting, are called mail merge fields. Fields in Word correspond to 

the column headings in the data file that you select. 
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 Columns in a data file represent categories of information. Fields that you add to the main document 

are placeholders for these categories. 

 Rows in a data file represent records of information. Word generates a copy of the main document for 

each record when you perform a mail merge. 

 

By putting a field in your main document, you indicate that you want a certain category of information, 

such as name or address, to appear in that location.  

 

 NOTE   When you insert a mail merge field into the main document, the field name is always surrounded 

by chevrons (« »). These chevrons do not show up in the merged documents. They just help you 

distinguish the fields in the main document from the regular text. 

What happens when you merge 

When you merge, information from the first row in the data file replaces the fields in your main document 

to create the first merged document. Information from the second row in the data file replaces the fields 

to create the second merged document, and so on. 



 

Working with fields: Examples 

You can add any column heading from your data file to the main document as a field. This gives you 

flexibility when you design form letters and other merged documents.  

For example, suppose you are creating a letter to notify local businesses that they have been selected for 

inclusion in your annual city guide. If your data file contains a Company column with the name of each 

business that you want to contact, you can insert the «Company» field instead of typing the name of each 

individual company. 

You can combine fields and separate them by punctuation marks. For example, to create an address, you 

can set up the fields in your main document like this: 

«First Name» «Last Name» 

«Street Address» 

«City», «State» «Postal code» 

For things that you use frequently, like address blocks and greeting lines, Word provides composite fields 

that group a number of fields together. For example: 

 The Address Block field is a combination of several fields, including first name, last name, street address, 

city, and postal code. 



 

 The Greeting Line field can include one or more name fields, depending on your chosen salutation. 

You can customize the content in each of these composite fields. For example, in the address, you may 

want to select a formal name format (Mr. Joshua Randall Jr.); in the greeting, you may want to use "To" 

instead of "Dear." 

Map mail merge fields to your data file 

To make sure that Word can find a column in your data file that corresponds to every address or greeting 

element, you may need to map the mail merge fields in Word to the columns in your data file. 

To map the fields, click Match Fields in the Write & Insert Fields group of the Mailings tab. 

 

The Match Fields dialog box opens. 

 



The elements of an address and greeting are listed on the left. Column headings from your data file are 

listed on the right. 

Word searches for the column that matches each element. In the illustration, Word automatically matched 

the data file's Title column to Courtesy Title. But Word was unable to match other elements. From this 

data file, for example, Word can't match Middle Name. 

In the list on the right, you can select the column from your data file that matches the element on the left. 

It is okay that Unique Identifier isn’t matched. Your mail merge document doesn't need to use every 

field. If you add a field that does not contain data from your data file, it will appear in the merged 

document as an empty placeholder — usually a blank line or a hidden field.  

Type the content and add the placeholders, or fields 

1. In the main document, type any content that you want to appear on every copy of the document. 

To add a picture, such as a logo, click Picture in the Illustrations group on the Insert tab. 

2. Click where you want to insert the field. 

3. Use the Write & Insert Fields group on the Mailings tab. 

 

4. Add any of the following:  

Address block with name, address, and other information 

Greeting line 

Individual fields 

Custom fields from Outlook contacts 

 

 NOTES  

 You can't type merge field characters («« »») manually or use the Symbol command on the Insert menu. 

You must use mail merge. 

 If the merge fields appear inside braces, such as { MERGEFIELD City }, then Microsoft Word is displaying 

field codes instead of field results. This doesn't affect the merge, but if you want to display the results 

instead, right-click the field code, and then click Toggle Field Codes on the shortcut menu. 
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Format the merged data 

Database and spreadsheet programs, such as Microsoft Access and Microsoft Excel, store the information 

that you type in cells as raw data. Formatting that you apply in Access or Excel, such as fonts and colors, 

isn't stored with the raw data. When you merge information from a data file into a Word document, you 

are merging the raw data without the applied formatting. 

Add formatting 

1. Select the mail merge field. Make sure that the selection includes the chevrons (« ») that surround the 

field. 

2. On the Home tab, in the Font group, apply the formatting that you want. Or click the Font Dialog Box 

launcher for more options. 

Preview, complete the merge, and print 

the documents 

After you add fields to your main document, you are ready to preview the merge results. When you are 

satisfied with the preview, you can complete the merge. 

Preview the merge 

You can preview your merged documents and make changes before you actually complete the merge. 

To preview, do any of the following in the Preview Results group of the Mailings tab: 

 

 Click Preview Results. 

 Page through each merged document by using the Next Record and Previous Record buttons in the 

Preview Results group. 

 Preview a specific document by clicking Find Recipient. 

 NOTE   Click Edit Recipient List in the Start Mail Merge group on the Mailings tab to open the Mail 

Merge Recipients dialog box, where you can filter the list or clear recipients if you see records that you 

don't want to include. 



 

Complete the merge 

You can print the merged documents or modify them individually. You can print or change all or just a 

subset of the documents. 

If you want to print a subset of the documents, you can specify the set by a range of record numbers. If 

you want to print pages instead of specifying record numbers, follow the instructions in the Change 

individual copies of the document section. 

Print the merged documents 

1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Print Documents.  

 

2. Choose whether to print the whole set of documents, only the copy that's currently visible, or a subset of 

the set, which you specify by record number. 

Change individual copies of the document 

1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Edit Individual 

Documents.  

 

2. Choose whether you want to edit the whole set of documents, only the copy that's currently visible, or a 

subset of the set, which you specify by record number. Word compiles the copies that you want to edit 

into a single file, with a page break between each copy of the document. 

After you finish editing the new file of documents, you can print the documents by clicking the File tab, 

clicking Print, and then clicking the Print button. 
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Save the main document 

Remember that merged documents that you save are separate from the main document. It's a good idea 

to save the main document itself if you plan to use it for another mail merge. 

When you save the main document, you also save its connection to the data file. The next time that you 

open the main document, you are prompted to choose whether you want the information from the data 

file to be merged again into the main document. 

 If you click Yes, the document opens with information from the first record merged in.  

 If you click No, the connection between the main document and the data file is broken. The main 

document becomes a standard Word document. Fields are replaced with the unique information from the 

first record. 

 


